
Storybuilder Help for 
2.2

Copyright ©  2011 Kingdom of The Netherlands



Table of Contents

1 Storybuilder Overview
1.1 About Storybuilder.............................................................................................................................                                                                                                                               4
1.2 Starting StoryBuilder..........................................................................................................................                                                                                                                            5
1.3 StoryBuild Structures .........................................................................................................................                                                                                                                           9
1.4 Storybuild ............................................................................................................................................                                                                                                                                              11
1.5 Storybuild types..................................................................................................................................                                                                                                                                    12
1.6 Autosave ..............................................................................................................................................                                                                                                                                                14
1.7 Storybuilder Lite Checklists...............................................................................................................                                                                                                                 15

2. Storybuilder Menus and Toolbars Overview
2.1 Opening a file......................................................................................................................................                                                                                                                                       20
2.2 Main Menu ...........................................................................................................................................                                                                                                                                             22
2.3 Toolbars overview..............................................................................................................................                                                                                                                                23
2.4 Workspaces..........................................................................................................................................                                                                                                                                           25

3. Drop down menus
3.1 File ........................................................................................................................................................                                                                                                                                                          30
3.2  Edit ......................................................................................................................................................                                                                                                                                                        31
3.3 Scale .....................................................................................................................................................                                                                                                                                                       32
3.4 Macros ..................................................................................................................................................                                                                                                                                                    33
3.5 Export data to a file............................................................................................................................                                                                                                                             35
3.6 View......................................................................................................................................................                                                                                                                                                        39
3.7 Toolbar.................................................................................................................................................                                                                                                                                                  40
3.8 Tools.....................................................................................................................................................                                                                                                                                                      41
3.9 Help ......................................................................................................................................................                                                                                                                                                        42

4. Toolbars
4.1 Standard Toolbar................................................................................................................................                                                                                                                                 43
4.2 Formatting toolbar .............................................................................................................................                                                                                                                               44
4.3 Navigate toolbar .................................................................................................................................                                                                                                                                   45
4.4 Line properties toolbar ......................................................................................................................                                                                                                                       46
4.5 Forms toolbar......................................................................................................................................                                                                                                                                       47
4.6 Box shortcuts toolbar.........................................................................................................................                                                                                                                          48
4.7 Macro toolbar ......................................................................................................................................                                                                                                                                        49
4.8 File option toolbar ..............................................................................................................................                                                                                                                                50
4.9 Pop-up option toolbar .......................................................................................................................                                                                                                                        51
4.10 Fold/Unfold toolbar..........................................................................................................................                                                                                                                           52

5. Storybuild Name Workspace
5.1 Selecting a Storybuild ........................................................................................................................                                                                                                                         53
5.2  Adding and deleting Storybuilds or change the name................................................................                                                                 54
5.3  Changing Storybuild orders in the list ...........................................................................................                                                                                            56
5.4 Import a Storybuild from another file.............................................................................................                                                                                             57

6. Boxes Workspace
6.1 Doing things with Boxes....................................................................................................................                                                                                                                     58

6.1.1 Box menu overview ...................................................................................................................                                                                                                                     59
6.1.2 Add box .......................................................................................................................................                                                                                                                                         61
6.1.3 Box editor ....................................................................................................................................                                                                                                                                      62
6.1.4 Insert box ....................................................................................................................................                                                                                                                                      64
6.1.5 Copying and pasting a box.......................................................................................................                                                                                                         65

1



6.1.6 Copying and pasting multiple boxes with or wirthout paths ..............................................                                               66
6.1.7 Cutting a box or a branch.........................................................................................................                                                                                                           67
6.1.8 Deleting a box or branch ..........................................................................................................                                                                                                            68
6.1.9 Selecting and deleting paths.....................................................................................................                                                                                                      69

6.2 Move mode - Box repositioning .......................................................................................................                                                                                                         70
6.3 Box view...............................................................................................................................................                                                                                                                                                73
6.4 Root box ..............................................................................................................................................                                                                                                                                                74
6.5 Dragging and scrolling the Storybuild ............................................................................................                                                                                             75
6.6 Painting tool ........................................................................................................................................                                                                                                                                          76
6.7 Copying images into a document ....................................................................................................                                                                                                      77
6.8 Background menu ..............................................................................................................................                                                                                                                                78
6.9 Box linking...........................................................................................................................................                                                                                                                                             79
6.10 Collapsing and expanding boxes ...................................................................................................                                                                                                     82

7 Pop-ups for hiding and revealing boxes
7.1 Making pop-ups ..................................................................................................................................                                                                                                                                    83
7.2 Changing pop-ups..............................................................................................................................                                                                                                                                86

8. Tree view
8.1 Getting tree view ................................................................................................................................                                                                                                                                  87
8.2 Tree view menu and data export.....................................................................................................                                                                                                       91
8.3 Navigating with tree view..................................................................................................................                                                                                                                   95

9.  Duplicate window
9.1 Using the duplicate window as a navigator....................................................................................                                                                                    96
9.2 Zoom ....................................................................................................................................................                                                                                                                                                      97

10. Paths
10.1 Path name workspace......................................................................................................................                                                                                                                       99
10.2 Paths Menu........................................................................................................................................                                                                                                                                          101
10.3 Paths...................................................................................................................................................                                                                                                                                                    102
10.4 Adding, deleting and renaming paths ..........................................................................................                                                                                           103
10.5 Making and editing paths................................................................................................................                                                                                                                  104
10.6 Multiple path edit..............................................................................................................................                                                                                                                               105
10.7 Make path visible..............................................................................................................................                                                                                                                                106
10.8 Selecting paths..................................................................................................................................                                                                                                                                   107
10.9 Path counts........................................................................................................................................                                                                                                                                         109
10.10 Paths in front ..................................................................................................................................                                                                                                                                    110
10.11 Path search......................................................................................................................................                                                                                                                                       111
10.12 Path notes .......................................................................................................................................                                                                                                                                         112

11. Statistics
11.1 Viewing data in a table....................................................................................................................                                                                                                                      114
11.2 Exporting data to MS Excel .............................................................................................................                                                                                                               116

12. Printing
12.1 Print function ....................................................................................................................................                                                                                                                                      118
12.2 Page breaks.......................................................................................................................................                                                                                                                                         119
12.3 Printer margin...................................................................................................................................                                                                                                                                    120
12.4 Page Setup ........................................................................................................................................                                                                                                                                          121

13. Identify required Storybuild
13.1 Identify required Storybuild ...........................................................................................................                                                                                                             122

14. Box codes

2



14.1 Box codes guide ...............................................................................................................................                                                                                                                                 124

15. Notes
15.1 Keeping notes ...................................................................................................................................                                                                                                                                     129

16. Importing data
16.1 Importing from an MS Excel file or text file.................................................................................                                                                                  130
16.2 Selecting import box........................................................................................................................                                                                                                                        132
16.3 Import window.................................................................................................................................                                                                                                                                   134
16.4 The import process..........................................................................................................................                                                                                                                            139

17. Making and running macros
17.1 Macro User Guide.............................................................................................................................                                                                                                                               140

18. Linking up with Story Filter
18.1 Selections and links with Story Filter ............................................................................................                                                                                             141
18.2 Dragging paths from Story Filter to Storybuilder .......................................................................                                                                        142

3



1.1 About Storybuilder
 
Version 23 August 2011 
© Kingdom of the Netherlands 2004-2011

 
Storybuilder is a PC based MS Windows application purpose built for recording and analysing accident information. 
As a database it uses a graphic structure of boxes, text and lines to store accident data and provides numerical results in 
response to user queries. 

It uses 

 Microsoft Access database.  
 MS Word and Excel for exporting data
 MS Excel for importing data

 
Files are installed from a setup.exe file. 
The extracted files are about 9MB in size

 

 For more information about Storybuilder see www.storybuilder.eu

See also separate documents:
Filename: Lite help 2.2 EN.pdf or Lite help 2.2 EN.pdf   (StoryBuilder Lite Help April 2011)
Filename:  WQ110822 Storybuilder Lite 2.2 Interface.pdf (Helpdesk StoryBuilder Lite 2.2 Interface)
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1.2 Starting StoryBuilder

You need 

The installed StoryBuilder program
A storybuilder file with extension *.sb

1.  Install the program by double clicking on the SetupStoryBuilder.exe file

2.  If possible put the sb file you want to open most often in the same directory as the  exe file (program directory).  
Storybuilder will open the first sb file it finds
If you put both these files in the program directory then it will open the _ANON file on opening (works alphabetically).

You can also open sb files from any location on your computer.

3.  Start the StoryBuilder program

You will see the splash screen 

followed by the version selection screen.

3.  Select Storybuilder version

Choose bewteen Lite and Expert Mode
(You can also switch modes after selecting)
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4. If the file you want is not loaded click on drop down menu Database, Open or use the Open button

NOTE: Storybuilder opens the first sb file it finds in the directory.  By default this will be blank.sb if there are no other sb 
files in the directory.

5. Open the anonymous database file (_ANON.sb) or the blank template (_blank.sb)  which has the same structure as the 
anon file but without the paths.

LITE MODE:
If you opened LITE mode it should now look something like the figure below.
See also separate documents:
Filename: Lite help 2.2 EN.pdf or Lite help 2.2 EN.pdf   (StoryBuilder Lite Help)
Filename:  WQ110822 Storybuilder Lite 2.2 Interface.pdf (Helpdesk StoryBuilder Lite)
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EXPERT MODE:
If you opened expert mode it should now look something like the figure below.  See 2.4 Workspaces
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1.3 StoryBuild Structures

1.3.1 Bowties

Structures are built as bowties. Boxes which are causes of accidents are built on the LHS and those which are the 
consequences and built on the RHS.

Bowtie structure

 

1.3.2 Parent and child boxes

StoryBuilder displays a graphical representation of data in the Boxes Workspace.
 

Boxes Structure

The data are organised as a branching structure of  Parent and Child boxes which are given various properties when 
building a structure

 Name

 Description
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 Colour

 Shape

 Number

 Code

1.3.3 Root box

There is a single parent that is the Root parent of all the boxes and from which many branches can be developed. 
Each Child box has only one Parent.

Modified boxes
 
Here the Root is the box coded CE which is the centre event.
 
Root Parent may have two sets of descendants, those on the Left Hand Side (LHS) and those on the Right Hand Side 
(RHS).

In Storybuilder accidents paths are built as scenarios going from left to right.

Storybuilder accident paths always go through the centre event.

 

10



1.4 Storybuild
 
A storybuild is selected by clicking on a storybuild in the Storybuild name workspace (bowtie list).

A pre-made Storybuild is a cause and effect bowtie diagram of events showing accident scenarios (pathways) passing 
through the diagram.

Structure without accident paths:-

Structure showing accident paths:-

A set of 36 storybuild files (or one superfile with 36 storybuilds), one for each hazard,  are supplied with Storybuilder on 
request to White Queen BV (see www.storybuilder.eu)
 
The storybuilds can be used for: 
 

 Incident investigation

 Getting information about safety barriers

 Inputting and analyzing own accident data
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1.5 Storybuild types

The storybuilds contain accidents of the following types. These types describe what happened to the victim
See also 13.1 Identify required storybuild

FALL FROM HEIGHT due to FALLING OFF or due to STRUCTURE FAILS WITH PERSON ON IT
The accident resulted in a fall from height. It includes the collapse of the structure while the person is on it and the collapse
results in the person falling from height
Fell off a Ladder (fixed, mobile, stepladder or rope)
1.1.1 Fall from height - ladder & steps
Fell off a Scaffold (mobile, fixed, cantilever, suspension, ladderjack)
1.1.2 Fall from height - scaffold
Fell off a Roof or raised fixed platform or floor (roof, roof under consruction, working platform, floor above another floor,
window sill, flyover, bridge, elevated grating, platfor or terrace against a wall ETC.)
1.1.3 Fall from height - roof/platform/floor
Fell into Hole or through Hole cover (pit, temporary opening, vent hole, functional opening, manhole, hole due to substandard
cover, floor)
1.1.4 Fall from height - hole in the ground
Fell from a moveable platform (elevators, lifts, boom and scissor lifts, cable lifts, lift trucks like forklift or stackers, working
mobile platforms)
1.1.5.1 Fall from height - moveable platform
Fell from a vehicle that was not moving
1.1.5.2 Fall from height - non-moving vehicle
Fell from height not intended as support area for work (e.g. masts, boxes, equipment for moving people, gymnastics
equipment, tanks, machinery, storage)
1.1.5.3 Fall from height - working on height unprotected

FALL ON THE SAME LEVEL
There is no height involved in the fall (surface, pathway, passage, road, indoor or outside)
1.2 Fall on same level

FALL DOWN STAIRS OR RAMP
The person fell down a fixed or temporary staircase, spiral staircase, stairs on a ship, or a ramp
1.3 Fall down stairs or ramp

STRUCK BY AN OBJECT NOT BEING HELD BY A PERSON
The object which contacts the person is a moving vehicle
2 Struck by moving vehicle
The object contacts the person by falling on them either from height or it topples over or collapses onto the person AND...
.....it has something to do with cranes:
3.1 Contact with falling object - cranes, part of cranes or crane loads
...it is NOT to do with cranes:
3 Contact with falling object - other than cranes, part of cranes or crane loads
The person is struck by a missile:
4 Contact with flying object
The object is rolling or sliding (not a moving vehicle)
5 Hit by rolling/sliding object
The object is hanging or swinging when it makes contact
8.2 Contact with hanging/ swinging objects

STRUCK BY AN OBJECT BEING USED OR CARRIED BY A PERSON
The object of contact is carried by another person or it is carried or being used by the victim but it is not a handheld tool
6 Contact with object person is carrying or using
The object of contact is a hand held tool operated by the victim
7 Contact with hand held tools operated by self

MOVING OR JUMPING INTO AN OBJECT
The victim moves into a stationary object or bumps into a person
9 Moving into an object

CONTACT WITH OR TRAPPING BY MOVING PARTS
The machine has moving parts and the victim contacts those moving parts
8.1 Contact with moving parts of a machine
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An object moves against a person and traps them against a static obect
8.3 Trapped between/against something

BURIED OR IMMERSED
Victim is buried by a large amount of a physical substance like earth or grain or sand due to collapse or downpour
10 Buried by bulk mass
Victim is in a liquid and they lose buoyancy or are trapped under the liquid
23 Impact by immersion in liquid

IN OR ON A VEHICLE WHICH LOSES CONTROL
Victim is in or on a vehicle which loses control
11 In or on moving vehicle with loss of control

CONTACT ELECTRICITY
The victim contacts active electrical parts directly, indirectly or by short circuit
12 Contact with electricity

CONTACT EXTREME HOT OR COLD SURFACE OR FIRE
The victim contacts an extremely hot surface or an extremely cold one or an open flame (which is not a fire burning out of
control) because of movement of either the victim or the damage source
13 Contact with extreme hot or cold surfaces or open flame
A fire is caused by a loss of control, including the victim's clothes catching fire, and the victim is exposed to the effects.
17 Fire

HAZARDOUS SUBSTANCE OR ATMOSPHERE
Contact is due to a LOC (LOSS OF CONTAINMENT) of a substance which carries a hazard, such as by spill or overflow,
and it is normal for the containment to be open
14.1 Release of hazardous substance out of Open containment
Contact is due to a LOC (LOSS OF CONTAINMENT) of a substance which carries a hazard
and the containment is normally closed
15 Release of a hazardous substance out of Closed containment
Contact due to explosion - substances are explosive, reactive (solid, liquid or gaseous):
27 Explosion
There is contact with a substance which carries a hazard through ingestion, inhalation or skin or eye contact but there was
not a LOC
14.2 Exposure to hazardous substance without Loss of Containment
There is contact with a hazardous atmosphere and the victim is confined
22.1 Exposure to hazardous atmosphere in confined space
There is contact with a hazardous atmosphere through breathing apparatus
22.2 Exposure to hazardous atmosphere through breathing apparatus

VICITM OF HUMAN AGGRESSION OR ANIMAL
The victim is caused harm by an aggressor who loses control
20.1 Victim of human aggression
The victim was injured by an animal including falling from it
20.2 Victim of animal behaviour

DIVING ACCIDENT
24 Too rapid (de)compression

EXTREME MUSCULAR EXERTION
The body is overloaded as a result of a sudden and extreme muscular exertion. This might involve equipment, lifting, sport,
rescuing, moving heavy objects etc.
25 Extreme muscular exertion
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1.6 Autosave
 
Storybuilder saves files with extension '.sb'.  
It will save a backup of the current work every ten minutes. 
This file is in the same directory as the original and has the file extension '.old'.  
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1.7 Storybuilder Lite Checklists

See also separate documents:
Filename: Lite help 2.2 EN.pdf or Lite help 2.2 EN.pdf   (StoryBuilder Lite Help April 2011)
Filename:  WQ110822 Storybuilder Lite 2.2 Interface.pdf (Helpdesk StoryBuilder Lite 2.2 Interface)

1. Open Storybuilder
To view Storybuilder Lite checklists select the Lite version, either at start up or using the Application mode drop down 
menu.  Switching between Lite and Expert mode is easy with the drop down

2. Select Database, Open 

Do this if the file you want has not been selected 
Tip: Storybuilder opens the first sb file it finds in the program directory. Otherwise you will have to open a database yourself.

Open the mother database with the data (name ends _ANON) if you wish to view entered data
Open the mother database without paths (name ends _blank) if you wish to enter your own data in a blank template.

3. For a full description of how to enter a path and use other Lite functions see:

StoryBuilder Lite Help - File: Lite help 2.2 EN.pdf or Lite help 2.2 EN.ppt
Helpdesk StoryBuilder Lite - File:  WQ110822 Storybuilder Lite 2.2 Interface.doc

4. Entering or examining  paths in bowties
When you are in Lite you can

1) Enter your own paths
2) Look at indivudal accidents from the database using the drop down edit function

In the database and blank template there are 36 Storybuild bowtie hazards grouped in 9 categories. Each has a checklist 
based entirely on the underlying database. The blue bars are bowtie groups
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When you have chosen a storybuild by selecting a checkbox the Centre Event will appear
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Or if you choose the Edit path button you can select a path from the path list 

and it will also load as a string of events........:
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2.1 Opening a file
 
New
Starting from scratch? Click on New and name your file.
This is what you will see if you open a new file - The first box that is created is called the Root box and this is the parent of 
all other boxes that will be created like a family tree.  Tree branches can be built to left and right of the root box. 
 

 
 
Open
Start Storybuilder and open a file with an *.sb extension.
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2.2 Main Menu
 
At the top of the tool is the main menu, consisting of dropdown menus called:
File
Edit
Scale 
Macros
Export
View
Toolbar
Tools
Help
For the beginner File, Scale, View and Help are the most important 
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2.3 Toolbars overview
 
Below the main menu are a number of Toolbars. Each of the toolbars are explained in a separate section, 4. Toolbars .  

The toolbars can be selected or hidden using the toolbar menu shown here by checking or unchecking the boxes
 

 
 

The toolbars are:
 
 
Standard
Basic work ing mode buttons

 
Formatting
Basic text and box properties copy paintbrush formatting options

 
Navigate
For getting around

 
Line Properties
For changing link  lines of the structure - advanced

 
Forms
For exporting data.  Tree view also helps with navigating

 
Box shortcuts
Quick  building bricks

 
Macro
Making demos with "Wormie" (help worm) - advanced
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File Option
Standard file options and more

 
PopUp option
For hiding and popping out parts of the graphic (space saving and neat)
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2.4 Workspaces
 
Below the Toolbars are a number of Workspaces. 

NOTE In 2.2 these are now tabs Bowties, Paths and Saved paths.  The older version layout is shown below

Storybuilder 2.2 Version layout
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Storybuilder 2.1 Version layout

 
2.4.1 Storybuild Name Workspace
 
To the upper left is the Storybuild Name Workspace, containing one or more Storybuild names. This is headed "Bowtie list"
By default a storybuild is given the name basic when a new file is created but you can change this. Clicking on a Storybuild 
name selects it in the Boxes workspace.  In the figure below there are many storybuilds in the name workspace and one 
has been selected

27



. Right clicking on it gives you options such as to change its name.

 
2.4.2 Boxes Workspace
 Selecting a Storybuild name on the left selects its associated Storybuild graphic in the Boxes Workspace. 

 
2.4.3 Path Name Workspace
Any paths that have been created have their path names shown here. Paths through a Storybuild can be added and 
selected in the Path Name Workspace.  

2.4.4 Saved paths workspace
When a path selection is made it can be saved here.  Right click for the menu

Select add.  A screen will appear with the paths, to which a name can be added (e.g. "Mobile ladders" )
This name will then appear in the saved paths workspace. When the saved path name is clicked those paths will again be 
selected
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3.1 File

 
The File Menu is located in the Application Main Menu.

 
 
New - New creates a new StoryBuild database in the current directory.
 
Open - Opens an existing StoryBuild database (*.mdb).
 
Open ScriptDB - Opens a "SB Program Data" file if the user wants to change from the default 
 
Close - Closes the file
 
Save - Saves the current StoryBuild file into the current default  directory.
 
Save As - Saves the current StoryBuild (*.sb) file with a name and directory that can be specified by the user.
 
Notes - Open a notepad function that allow the user to type and save notes with the file.  
 
Import Storybuild - Allows storybuild file to be imported from external StoryBuild databases

Import StoryFilter Paths - Imports an "sfp" file which contains exported filtered paths from StoryFilter [NB StoryFilter is a 
separate program]
 
Set margins - Sets margin sizes for printing. See Printer Margin
 
Page Setup - Sets up the page for printing. See Page Setup
 
Printer Setup - Opens the Print Setup dialogue of the user's printer
 
Print - Opens the Print dialogue of the user's printer
 
Exit - Exits the StoryBuild application, changes to StoryBuild are preserved.
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3.2  Edit
 
The Edit Menu is located in the Application Main Menu.
 

 
 
 
Copy Copy takes a graphical snapshot of the boxes workspace and copies it to the Windows Clipboard for use by graphics 
programs such as Microsoft Paint.
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3.3 Scale
 
The scale can be set in the drop down scale menu and allow the user to set the viewing scale of the bowtie to the preset 
10%, 25%, 50%, 75%, 100% or to a custom size where the user could input their preferred percentage in the Other option.
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3.4 Macros
 
Macros refer to animations which show the user some aspect of Storybuilder functionality or some aspect of a Storybuild 
structure.
For detailed information about Macros the Macro User Manual should be consulted (a separate guide). 
However, it is possible to experiment with macros by typing in texts and clicking on boxes as described below
Running  and Customising Macros
StoryBuilder macros can be run from the Macros menu option or Macro toolbar. 

 

 
 
 
 
 
Creating Macros unique to a Storybuild
To create Storybuilder macros that are specific to a single Storybuilder file open a Storybuild then go to Macros | Record 
New Macro (Macro button). 
To play a recorded macro go to Macros|Play (Play button).  When the file is saved the macro will be saved with it.  
 
Demo Macros
For Storybuilder macros that are not file specific use Macros|Run. 
The run dialog box allows data to be entered that customises the built in macros.
The list shows available macros.  Entering text at $0, $1 etc. puts the text at the appropriate points in the scripts for the 
relevant macros
The last clicked boxes are also used in the scripts 
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Scripts
Scripts allow the built in macros to be changed using Macros|Scripts (button Script)
Scripts are stored in the 'SB Program Data.mdb' file (in MSAccess).  Edits to the script will be permanently stored. 
To see more about scripts go to Macro User manual (separate document)
 
Changing the Program Macro File
Standard macros that are not specific to a Storybuild are stored in a file called 'SB Program Data.sb'. When Storybuilder 
starts, this is the default macro file. However, it is possible to open a different file with the File | Open ScriptDB menu option.
Different macro files based on the supplied SB Program Data.mdb file can be made. To make a new one, copy it to another 
folder and give it a new name.  To open a macro file different to the default at the start of a session use File|Open ScriptDB. 
The scripts can be modified using the script editor.  Scrpts can also be edited outside Storybuilder by opening the file in MS 
Access. 
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3.5 Export
 
The export menu provides a variety of ways for exporting box names and data as .txt files which can then be opened in MS 
Word and MS Excel for example. 
This includes, for example, a list of boxes with paths counts <Storybuild> and the Lite Checklist (when created) for the 
selected Storybuild bowtie <Creation>. Exported data can then be printed or added to another document.

 
Note that the Selected Path Boxes Grid will stay greyed out until the Path Search view is open (see View Menu)
 

 
In each case a text file is created which consists of individual fields separated by tabs. These can then be loaded into any 
other program such as MS Excel and the data manipulated as required. The various export functions are listed below:
 
NOTE: Data can be exported directly to MS Excel using Statistics and to MS Word using Object Tree View
 
1. All Storybuilds:  This is designed to export data about the individual boxes that go to make up all the Storybuilds in a 
file The fields that make up this report are:  Storybuild name, Box Number, Code, Name, Description, Left Children, Right 
Children, Linked Boxes, Path Count, Paths. 
 
2. Storybuild: This is designed to export data about the individual boxes that go to make up the Storybuild which is 
selected. The fields that make up this report are:Box Number, Code, Name, Description, Left Children, Right Children, 
Linked Boxes, Path Count, Paths. 
 
3. Box Paths: This produces a subset of the bowtie report; in particular, it lists details of the paths through each box. The 
fields listed are: Number, Name, Count, Paths.
 
4. Path List*: This lists the relevant paths together with the box sequences they represent. A 'Subpath' field is also present; 
an 'X' in this field indicates the path is a subpath and its parent is the first path above it without an 'X'. The fields listed are: 
Name, Subpath, Sequence. This option will initially ask whether only the selected paths should be used for the operation. 
 
5. Path Sequences: This exports all path sequences together with the names of paths that follow those sequences. The 
fields listed are: Sequence, Names. This option will initially ask whether only the selected paths should be used for the 
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operation.
 
6. Path/Box Grid: This exports a table. Along the top are the names of paths and down the left hand side is a list of box 
names. In the body of the table, an 'X' indicates that a given path contains a given box.  See example below
 

 
7. Selected Path Boxes grid: This exports a table based on what is selected in Path Search view (see 10.11 Path 
Search). Along the top are the names of the boxes selected and down the left hand side are the names of the paths. An X 
indicates when a selected path is going through the box. The two examples below are for the same box numbers but first 
using AND and secondly using OR.
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8. Creation This exports checklists which have been made in creations.  
(for exporting a list of boxes see 8.2 Tree view menu and data export or 11.2 Exporting data to Excel)
The complete Lite Checklist defined in Creation for the opened storybuild is exported as a txt file.  The file is created in the 
user's choice of location.  The user can open the file in Word for example and save as a Word document.  
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3.6 View
 

 
 
 
Path search. When Path search is selected it opens an area below the workspace where path queries can be built
 
Popup controls the visibility of popups.A submenu is shown in the figure above. Boxes which are given Popup numbers can 
be displayed or hidden by selecting or deselecting the relevant Popup number. For example in many of the WORM 
storybuilds popups are used to hide the Delivery Systems (code DS)  and Barrier tasks (code T) 
 
Page breaks displays the Printing layout.  The location of page break positions on the Storybuild graphic can be viewed.
 
Path Count info displays path frequency information under the boxes (or switches it off if selected) 
 
Paths in front specifies whether the paths pass in front of or behind boxes.  Deselecting this can be useful when there are 
a lot of paths covering up information as it puts the paths behind.
 
Duplicate  is for navigation. It duplicates the workspace and and can be set at a smaller scale. It enables navigation and 
zoom by drawing a box round a selected area. See Duplicate 
 
View statistics shows a list of boxes and paths that go through them, depending on the selection.    Statistics can be 
exported directly to Excel. See View Statistics
 
Path notes displays all the path names and any notes made about those paths.  See Path Notes
 
Box view can be useful for switching off certain box display attributes. Box View allows the user to specify whether they 
want to see the Code, Name, and Box number displayed in the boxes and what their position should be 
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3.7 Toolbar
 

\
 
Toolbars can be selected or deselected to show on the toolbar area.
By default the macro toolbar is not shown on start-up
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3.8 Tools

In the drop down menu Tools is found Settings.

By choosing Settings the user is given the option to change where temporary paths are opened.

These are paths for the storybuilder files and the SB program data file.  Changing the paths is desirable when the user does 
not have administrator rights.

The selected paths are saved in an ini file SBSettings.ini in the Users\User name\Documents directory
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3.9 Help
 
 
The Help Menu is located in the Application Main Menu.
 
Help - StoryBuilder help can brought up by selecting this option or by pressing F1.
 
Search for Items - Bring up the Help search function.
 
About StoryBuilder - StoryBuilder Author and Version information 
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4.1 Standard Toolbar
 

 
4.1.1 Modes of Operation: 4 buttons
 

 
StoryBuilder has four basic modes in which it can operate depending on which part of the building or analysis process is 
being handled. 
These modes are:|
 
Fixed Mode: This allows boxes to be added or deleted and their properties to be altered. It does not allow them to be 
moved. This mode is best for data analysis (selecting and counting paths). 
 
Move Mode: The Move mode is similar to the fixed mode except that it allows boxes to be moved about. The purpose of 
this is to allow editing of the structure. (See Box positioning.)
 
Link Mode: A user defined line. This is used for creating and deleting links between the boxes when you need some extra 
lines in the structure and which are not created automatically. (See Box Linking.)
 
Paths Mode: Paths through the structure can be added and amended in this mode. They follow the lines of the structure 
and can be counted in the boxes. (See Paths.)

 
4.1.2 Path select and deselect: 3 buttons
 

 
In addition there are buttons for viewing paths
 
Select all: Selects all paths
 
Deselect: Deselects all paths
 
Make visible: Makes visible all selected paths (note that they might still not be visible if there are Popups not activated)
 

 
4.1.3 Box numbering: 1 button
 

 
Renumber: This automatically renumbers all the boxes to ensure that there is a continuous numbering sequence.  This is 
sometimes required because adding a new box takes the next box number according to previous operations and not 
according to the last visible number.  
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4.2 Formatting toolbar
 

 
This offers standard formatting options

 
4.2.1 Box Properties Text
 
Font and letter size, as well as bold, italic and underline affect the text display in the boxes.  Arial 8 pt usually comfotably 
fits.

 
4.2.2 Box properties painting tool
The format paintbrush works on box properties and will paint colours, codes and shapes.
 

 
Located on the formatting toolbar the format painter tool allows the property of a box to be applied to other boxes. 
To use it make sure the Fixed or Move mode is selected (see 4.1 Standard Toolbar), depress the tool button and click on 
the box which has the properties to be copied and then Ctrl click on the box or boxes to which the properties are to be 
applied. If only the box code is to be copied hold down Ctrl and Alt then Click 
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4.3 Navigate toolbar
 
4.3 Navigate Toolbar

 
 
See 9.1 Using duplicate window as navigator and  6.4 Root
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4.4 Line properties toolbar
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4.5 Forms toolbar
 

 
 
The two forms provide ways of viewing data that can then be exported.
 
Statistics lists the boxes in a matrix with all the box attributes for the purposes of examining path counts.  The default is to 
show all the paths. See Statistics for how to use this form.
 
Tree View displays a tree of the graph without the graphics in graph structure and code view.  The Object Tree View shows 
path frequencies and the % of the total selected paths which can be exported to Word. Useful for making quick tables of % 
contributions.  Tree view is also a navigator. 
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4.6 Box shortcuts toolbar
 
 

 
Enables predefined structures to be entered into a storybuild.  A composite of the building blocks is shown below.  By 
clicking on a box and clicking on a shortcut the single box or branch of boxes is produced.  These are A - Activity branch, 
BFM - Barrier failure mode, LCE - Loss of Control event (attach to BFM), IF Influencing factor, T - Tasks branch (attach to 
BFM), DS - Delivery system branch (attach to tasks)
See 14 BOX CODES .
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4.7 Macro toolbar
 

 
For a simple introduction to running and creating macros see 3.3 Macros menu 
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4.8 File option toolbar
 

 
 
New - New creates a new StoryBuild database in the current directory.
 
Open - Opens an existing StoryBuild database (*.mdb).
 
Save - Saves the current StoryBuild file into the current default  directory.
 
Print - Opens the Print dialogue of the user's printer
 
Copy - Copies the entire Storybuild graph as displayed to clipboard so that it can be pasted into other applications
 
Help - Opens the Help File
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4.9 Pop-up option toolbar
 

 
 
Parts of the structure can be hidden away and made to reappear as pop-ups.  There are 5 pop-up numbers 
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4.10 Fold/Unfold toolbar

A structure can be completely folded into the root box or completely unfolded.
Unfolding does not show pop-ups
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5.1 Selecting a Storybuild 
 
A file may contain one or more storybuilds.  These are listed in the Storybuild Name Workspace.
Storybuilds are graphics with lines and boxes. Selecting a Storybuild selects the respective graphic. 
File, New - creates a new StoryBuild database.
 
File, Open - Opens an existing StoryBuild database (*.sb or *.old).
 
To add a new storybuild to an existing file, delete a storybuild or edit the name see 5.2 Adding and deleting storybuilds.
 
In the Figure below a number of storybuilds are shown in the Storybuild name Workspace of which 24 Too rapid 
(de)compression is selected. To select a Storybuild move the cursor to the required Storybuild and click the left mouse key 
to select.  It can take a few seconds to appear if it is a big structure with a lot of paths.
 

53



5.2  Adding and deleting Storybuilds or change the name
 
Right mouse click on the background of the Storybuild Workspace to open up the storybuild name menu.

 
 
The name menu facilitates the following operations:
 
Add - Adds a new Storybuild name permitting a new structure to be built in the Boxes Workspace. An Edit box is produced 
during the addition to allow details to be added to the Storybuild
 
Edit - A new name and short description can be added. 
The Storybuild Edit dialog box enables name and description of the Storybuild to be edited 
Name - A name for the current Storybuild
Description - Annotate a useful short description. 

 
 
 
Copy - This enables a complete Storybuild with all its paths to be copied.  A new Storybuild called Copy of [name of 
original] will appear
 
Delete - Deletes the currently selected Storybuild and its boxes and paths.
Edit Notes - Opens the note dialogue box for users to keep notes on the complete storybuild file
Delete Notes - Delete the notes.
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5.3  Changing Storybuild orders in the list
 
The user is able to move the Storybuild orders displayed in the list.  To move a Storybuild up or down simply click on the 
name from the list and wait for it to load.  Hold down your left mouse button and drag and drop it onto the location where 
you want it to be. A rectangle symbol appears on the cursor to show whether you have indeed grabbed it 
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5.4 Import a Storybuild from another file
 
 
Allows the selection and addition of one or more Storybuilds to be imported from a different Storybuild file to the one open.  
To import a Storybuild, go to File and then click on Import Storybuild.  An initial file selection box is opened. Choose a 
StoryBuilder database file to open. Once opened, an Import Storybuild box is displayed, showing Storybuilds within the file 
that are available for selection. Click on the required Storybuild to import
 
Press ctrl or shift whilst selecting with the mouse to import  more than one Storybuild.
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6.1 Doing things with Boxes
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6.1.1 Box menu overview
 
The box menu is available in Fixed, Move and Link modes. 
 
(See  4.1 Standard Toolbar) 
 
Right click on a box to open up the action menu. Most of the menu items are self explanatory.  However Edit box will open 
up a dialogue box. You can also open the Edit box by double clicking on the box
 

 
The boxes menu enables the following operations on  the currently selected box:
 
 
Add Left Box - Adds a new box to the left, under the current box.
 
Add Right Box - Adds a new box to the right, under the current box.
 
Insert Box - Adds a new box in between the current box and the Parent box.
 
Edit Box - Opens up an Edit box to modify the box details. This can also be achieved by double clicking on a box
 
Delete Box - Deletes the current box. 
 
Make Root - Makes the current box the root of the Storybuild (the parent of all other boxes).
____________
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Auto Position - Auto arrange the Storybuild with the boxes into an orderly fashion. (See 6.2 Move mode - Repositioning)
 
Include in Auto Layout - Toggle the option of this box to be included in the Auto Layout function, essentially an 
auto-arrange function for all the boxes. (See 6.2 Move mode - Repositioning)
____________
 
Select Paths - Select all the paths that goes through this selected box.
 
Show Linked Boxes - Shows all boxes linked with current box.
 
Delete Box From Paths - Deletes the selected paths from passing through the box.
____________
 
Cut Box - Removes the current box, allowing the box to be pasted elsewhere if required  -effectively moving the box. 
 
Copy Box - Duplicates the current box, allowing a copy of the box to be pasted elsewhere.  
 
Paste - Pastes the previous Copy action
 
Insert Paste - Inserts a previously copied/cut box, or multiple boxes, in between the current box and its Parent box.
____________
 
Edit Branch - Enable the user to edit the box properties for all the boxes attached to its branch.
 
Cut Branch - Removes the current branch (selection of boxes), allowing the box to be pasted elsewhere -effectively moving 
the whole branch. 
 
Copy Branch - Duplicates the current branch, allowing a copy of the branch to be pasted elsewhere.  
 
Delete Branch - Deletes the selected box and its branch.
_____________
 
Copy Branch With Pathset - Makes a duplicate copy of the branch with all of its paths.
 
Copy Branch Without Pathset - Makes a duplicate copy of the branch without its paths.
 
Set Ancestor - Sets the current box as the Ancestor box (only relevant for import functions) See 16.3 Import window.
 
Export Branch Table - Export the selected branch data.
 
Export Box Subsequences - Export the subsequences of the selected box.
 
Import Path Data - Import path data using a dialogue form (from txt file)
 
Import Excel Path Data - Import path data via an excel worksheet.
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6.1.2 Add box
 
Add Left Box, Add Right Box.
 
Boxes are added to StoryBuilder individually. Adding a box produces a new Box, ready for editing, to the left or right of the 
current selected box.
 
To add a box, right click on box and choose 'Add left box' or 'Add right box'. An Edit box will appear (see 6.1.3 Box edit), fill 
out the optional details, and press the Ok button to complete the addition. 
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6.1.3 Box editor
 
Right click on a box and choose Edit Box OR simply double click on a box.

The Edit Box dialog box appears.  This box enables the creation and modification of attributes associated with a box. 
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Side - Specifies which side the Box will be located in relation to it's parent, a left or right link.
 
Code - A code identifying the category of the Box.
 
Box Type - The popup type of the box.
 
Box Num - The Box number. Boxes get numbered automatically but the use can change this.  See also Renumber on the 
Standard Toolbar
 
Name - A name for the current Box.
 
Description - Add a useful short text description which will appear when you hold your cursor over the box. 
 
Border Colour - The colour of the border around the Box.
 
BorderWidth - The width of the border surround.
 
Fill Colour - Specifies the Box colour.
 
There is 2 additional option that allows the user to edit the position of a box.  
 
User Position - If this check box is checked, the box is being displayed in a user position (uncheck it if you want the box 
to go back to auto position). (See 6.2 Move mode - Repositioning)
 
Include in Auto Position - If this check box is checked, the box is included in the auto position of the bowtie.
 
For more information on how to customise the box positioning see  6.2 Move mode - Repositioning. 
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6.1.4 Insert box
 
Right click on a box and choose Insert Box. Inserts a new box, ready for editing, between the currently selected box and its 
Parent box.  
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6.1.5 Copying and pasting a box
 
Copy - Right click on a box, choose the Copy action then move the mouse to the box to copy to, right click and choose the 
Paste action.
You can also paste the box into MS Office applications.
 
Paste - Pasting completes a  Cut or Copy operation. Right click on the box where you want to make the paste and choose 
paste from the menu.
Pasting maintains a Box's attributes. 
Paste depends on the nature of the previous operation.
All paste operations place the Box(es) as children of the currently selected Box.
You can also paste the boxes into MS Office applications.
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6.1.6 Copying and pasting multiple boxes with or without 
paths
 
Copy and paste boxes
To copy (duplicate) multiple boxes right click on the box and choose copy branch. Select a parent box at the start of the 
required branch within the Boxes workspace. Move the mouse to the box to copy the boxes, right click and choose paste to 
complete the action.
Using copy branch on the root box copies all the branch boxes.
You can also paste the boxes into MS Office applications but it will only paste the displayed boxes in a branch
 
Copy and paste boxes with paths selected
When paths are selected:
For copying and pasting paths together with a branch choose Copy Branch With Pathset
For copying a branch without the pathset choose Copy Branch Without Pathset
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6.1.7 Cutting a box or a branch
 
Right click on a box, select Cut Box.  The box is removed and can be pasted onto another box by right clicking on it and 
choosing Paste to complete the action. 
 
To cut multiple boxes in a branch choose the branch parent, right click and choose Cut Branch from the menu.  The 
branch can be pasted onto another box in the usual way.
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6.1.8 Deleting a box or branch
 
NOTE: A deleted box cannot be pasted. If you want to cut and paste see
To delete a box right click on it and select delete box. Respond to the confirmation box to complete the action.
The tree structure is preserved such that when boxes that have children are deleted immediate children of the deleted box 
move up the tree and take the place of the deleted box.
To delete a branch perform the same operation but choose delete branch
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6.1.9 Selecting and deleting paths
 

 
Select - Clicking on Select Paths selects all the paths going through that box.
 
See topic 10.8 Selecting paths
 
Delete - When paths are selected, to delete selected paths from a box click on Delete Paths.  This is the best way to 
delete multiple paths from a box.
 
See also topic 10.6 Multiple Path Edit 
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6.2 Move mode - Box repositioning
 
Boxes can be repositioned in Move mode only. (See Modes of Operation.) Using Drag and Drop operations objects can be 
moved and repositioned freely throughout the StoryBuild structure.
 
To move a box to a different location:
 
1. Go into Move mode
2. Click on the box and drag it to the new location above or below other boxes.  The symbol on the cursor will change to a 
small rectangle when the box can be dropped
 
In the following example box 16 is selected and moved between boxes 19 and 13
 

 
After the drop operation Box 16 is repositioned between 19 and 13.
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Move to a different parent:
 
1. Go into Move mode
2. To reposition and move a box to a different parent, the ctrl key should be pressed during the drag and drop and the box 
dragged onto the new parent. Again a small rectangle will appear when the drop is possible.  
3. Drop the box on the new parent. The box will reconnect to its new parent.
 
User defined position - 
 
1. Go into Move mode
2. To position a box anywhere in a user defined position on the background  hold down the Ctrl +  Alt key when moving the 
box then drop it.  
3. When a box is user positioned it overrides the automatic positiong which keeps boxes from overlapping.
 
A user defined positioned box is identified by a small green dot with a red border
 

 
To return a box to auto position
 
1. Left click on a box and select Auto position from the Box menu
 
or
 
1.  Select  box edit from the box menu and unclick User Position.
 
To prevent boxes overlapping
A box can be added or removed from auto layout.  By default it is in auto layout which prevents boxes from occupying the 
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same space. To include it in auto layout use either the Box menu  or the Box edit
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6.3 Box view
 
There is an option to customise the information displayed on a box via the BoxView menu.  To access the box view menu 
select View then click on BoxView.  The following form will appear:

 
 
Simply select the information that you would like to display on the Top Left, Top Right and Main window of the boxes via the 
drop down menus.  
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6.4 Root box
 
6.4.1 Location of the root
 
The root box is the centre of the bowtie and is indicated by a small line in the top left corner of the box. All other boxes 
branch off from this box. The Root box cannot be deleted (but it can be edited to change its name and properties). 
 
In order to locate this box in the Boxes Workspace, click on the root button in the Navigate toolbar.

 
6.4.2 Locating other boxes using the root button
 
Holding down Ctrl when clicking on the Root button in the toolbar provides a Find Box dialogue if you know the box number
 

 
When the box number is entered then box of that number will appear in the centre of the Boxes workspace. If the box is not 
visible in the current view go to Collapsing and Expanding boxes

 
6.4.3 Setting the root
 
The user is able to set any box in the bowtie as the root box. Right click on the box you wish to set and click on Make 
Root. 
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6.5 Dragging and scrolling the Storybuild
 
By holding the shift key down and left mouse button, dragging the StoryBuild image is possible using the hand cursor to 
bring different parts into view.  Normal scrolling with the scroll bars can also be used to move the Storybuild. 
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6.6 Painter tool
 

Located on the formatting toolbar the painter tool allows the property of a box to be applied to other boxes. 
1) Make sure the Fixed or Move mode is selected
2) Click the painter tool button and click on the box which has the properties to be copied 
3) Ctrl click on the box or boxes to which the properties are to be applied. NOTE: If only the box code is to be copied hold 
down Ctrl and Alt then Click  
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6.7 Copying images into a document
 
To copy a part or all of a storybuild see 6.1.5 Copying and pasting a box and 6.1.1 Copying and pasting multiple boxes
This operation is available in Fixed, Move or Link mode. 
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6.8 Background menu
 
Right mouse click on the background of the Boxes Workspace to open up the background menu: 
 
Copy - Copy takes a graphical snapshot of the boxes workspace and copies it to the Windows Clipboard for use by 
graphics programs such as Microsoft Paint or pasting into MS Word. 
 
Export to Text File - Export to file takes a representation of the current workspace, producing a text file of the information 
about the paths. The txt file can be opened in excel. NOTE: This function is also available in the drop-down Export menu.  A 
direct export to MS Excel is available from the Statistics screen
 
Edit Notes - Opens the Storybuild file note dialogue box for users to keep notes on the Storybuilds
Delete Notes - Delete the Storybuild file notes. 
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6.9 Box linking
 
StoryBuild boxes can be linked to represent relationships when these lines are not produced automatically in the parent 
child structure,.
 
Links are created in a similar way to drag and drop operations. To draw a link between boxes, ensure that StoryBuild is in 
Link mode, select the start box of the link by clicking the left mouse button (keeping it depressed), move to the target box 
and then release the button. In the following example box 295 is linked to box 1. 
 
Properties of link lines can be set and modified (see 6.9.1 Box Link line properties).
 
Box links can be deleted by selecting the link line, right clicking the mouse button and selecting delete.
 
(See also 6.9.2 Show Linked Boxes)  
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6.9.1 Box Link line properties
Properties of links lines (width and colour) can be set prior to creation by clicking the Link width and link colour buttons 
(see figure above)
 
To modify a link line property in Fixed Mode select the required line property and press ctrl left-mouse click on the target 
link line. (Left-mouse clicking on other link lines in this manner, will apply the current set property). 
 
This operation is available in Link mode. 

6.9.2 Show Linked Boxes
Expands and shows all boxes linked to current box
In the following example, box 117 has been expanded by selecting the Show Linked Boxes from the box menu. 
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6.10 Collapsing and expanding boxes
 
The + and - signs on the boxes indicate that the box can be expanded (+) into the child branches or collapsed (-) into the 
parent box by clicking on them.  Clicking on + expands the box and clicking on - collapses it.  A box can have branches on 
either side.
 

 
Holding down the CTRL key when collapsing (-) will result in all the generations of the parent box being collapsed, such that 
when the parent is expanded it will do so generation by generation. 
 
If the CTRL in held down when expanding (+) the child branches will be expanded for all generations.
 
Tip: Using CTRL (-) for each side of the root box will totally collapse the structure and then enable the structure to be neatly 
opened generation by generation as each (+) is clicked.
Using CTRL (+) for each side of the root box will completely expand the structure to show all generations.
 

 
Collapsing and expanding boxes can also be done with pop-ups.
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7.1 Making pop-ups
 
1.1 What are popups?
 

 
Popup boxes are boxes that can be hidden when not needed. This can be useful when structures are very big and children 
of a box which are not interesting for the key structural elements can be hidden away until needed. 
 
Pop-up numbers are assigned to boxes using the drop down menu
 

 
Assigning a pop-up number
 
A box can be assigned a popup number from 1-5.  Non-popups have the value 0:
1. Pick a number from the drop down menu
2. Click on the Pop button.  It will turn blue
3. Click on a box.  It will be assigned that pop-up number (or none if 0 is chosen to undo earlier pop-ups)
4. To deselect the pop-up assigning option click the Pop button again and the colour will revery to normal.
 
 
It is possible to make all Popups of a given number class hidden or visible using the toolbar or view menus.
 
See 4.9 PopUp Option Toolbar and 3.6 View Menu.
 
Below is an illustration of a box 
a) with Popup boxes showing:
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b)   with the Popups hidden:

 
 
There are five classes of popups numbered 1 to 5 (with normal boxes numbered 0). If a box has any popups that are not 
currently visible, a filled in circle will appear above it (see b).
In order to make the popups visible, ensure that the left or right branch (as appropriate) of the box is expanded and click on 
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the circle. The circle will become hollow and all popups for that box will be displayed. These will be linked to the parent box 
with a dotted line; a number indicating the popup class will appear in the top left. (see a.)
 
Thus, by choosing 'Popup 1', all Popup 1 boxes will become visible(assuming the relevant branch is expanded). Choosing 
the menu item will make popup 1 boxes revert to their normal behaviour. 
When a popup type is selected the button turns blue.  Click on it again to deselect (pop back) the boxes.
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7.2 Changing pop-ups
 
There are two ways of changing the popup type of a box. The first is by changing it in the usual edit dialogue. (See Editing a 
Box.)  
The second way is designed for changing large numbers of boxes. To do this, click on the pop button in the toolbar so that 
it appears depressed (blue). Set the corresponding number in the drop down box next to it to the popup type you want.

 
Then click on the boxes you want changed. When you are finished, click on the pop button again. 
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8.1 Getting tree view
 
Select Object Tree View from the Forms Toolbar or the View Menu
A window appears on the right hand side.  The width can be increased by dragging the divider. The window can also be 
decoupled from the main window (see 8.2 Tree view menu and data export ). 
Three views are offered - Graph View, Code View and Numberless code view.
 
PURPOSE: 
Object tree view displays the number of accident [and victims] and as a percentage of the total number of paths selected. 
See 8.2 Tree view menu and data export  to find out about refreshing the data to match the selection.
 
It will export these data for the expanded parts of the tree to MS Word or Excel
Double clicking on a tree branch makes the graph jump to the box (or the place where it would be if the structure were to be 
opened)
 
VIEWS
 
Graph view - Presents all the boxes as a tree in the form of the Storybuild structure
 
Code View - Groups the boxes with the same code, then presents them beginning with the first number or letter.  
Advantage over numberless code - all the codes beginning with the same number appear together in sequence.  - See 14 
Box codes.
 
Numberless view - Ignores any numbers in the code then groups and presents groups alphabetically.  This is handy for 
showing groups of items with common letter codes e.g. all BFMs appear together.  - See 14 Box codes.
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These views can be expanded and collapsed. 
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8.2 Tree view menu and data export
 
Right clicking within the Object Tree View frame provides the Object Tree View Menu
 
 

 
The menu has the following options:
 
Stay on top - when the tree view window is decoupled from the main window it stays on top if this is selected. To decouple 
it click on the top of the frame and a red frame will appear. Drag to a new location.
 
 

 
 
Relocated tree view (drag to where you want it):
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Refresh - IMPORTANT for showing current data. Updates the data in the tree to match the current paths selection. The 
percentage is expressed as the percentage of the number of paths selected
 
 
Expand graph view - Fully expands the current graph
 
 
Collapse graph view - Fully collapse the current graph
 
 
Jump to graph - When a tree branch is selected, jumps to relevant part of the Storybuild.  This can also be achieved by 
double clicking on a branch.
 
Export selected boxes to MS Word - With paths selected and the tree view refreshed the data on opened branches will 
be exported to MS Word.  Opening up selected branches defines the data that will appear in a table
 
Export selected boxes to MS Excel -  With paths selected and the tree view refreshed the data on opened branches will 
be exported to MS Excel.  Opening up selected branches defines the data that will appear in the sheet
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The export from Tree View where the BFM codes were opened is shown below . Data is shown exported to MS Word.
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8.3 Navigating with tree view
 
Jumping to a box
Double clicking on a branch in tree view takes the user to the box in the Storybuild provided it is visible.  
If the box is not visible (white space)
1. Try using the Make Visible button - this works only if paths have been selected which go through the box. See 4.1 
Standard Toolbar.
OR
2. Click on Goto Root (see Navigate Toolbar) and collapse the left and right branches.  Then hold down Ctrl when opening 
the branches.  This opens up the branches totally.  See 6.10 Collapsing and Expanding boxes.
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9.1 Using the duplicate window as a navigator
 
The Duplicate Window functionality in StoryBuilders allows the user to view the workspace in another window to help with 
manoeuvering around the Storybuild.  Any changes within the Duplicate Window will not affect actual data.  To open the 
Duplicate Window, click on the Duplicate View button on the Toolbar. 
 
The Duplicate View toolbar allows the user to view the Storybuild in various formats including fonts, scale and size.  The 
Root button will bring the root box into centre view.  
The Zoom function allows the user to zoom in on an area in the main window.  See Zoom
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9.2 Zoom
 
StoryBuilder has a zoom functionality in the Duplicate Window.  
With the 'Zoom' Toggle button down you can click and drag an area on the Duplicate window which you would like to zoom 
in on in the main Boxes workspace of the Storybuild. This appears as an area bounded by a dotted line.

 
The area selected will fill the workspace window as soon as the click and drag is released.
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10.1 Path name workspace
 
Accident scenarios are represented as paths through the structure.

In  Path Mode Paths can be made from one box to the next for representing accident scenarios in the boxes workspace.  

The path represents an accident. One victim accidents have one path. Multiple victim accidents have a parent path with 
children. 

To make path names have to first be created in the path name workspace. See Adding, deleting and renaming paths

 

 

The above figure shows that when a path goes through a box it adds to the path count.  This is shown under the box.  The 
number of victims is shown in brackets. In this case there is only one accident and one victim shown/
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10.2 Paths Menu
 
To get the menu right click in the Path Name Workspace
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10.3 Paths - Accident scenarios
 
Paths are routes between several boxes that indicate the sequence of events. They are used to record details of an 
accident. Paths are indicated by a red line with a small filled blue circle indicating where a path starts. The individual paths 
are listed in a tree in the lower left frame. 

 
Main paths are listed with any subpaths of a given main path listed as children. Where a path splits into children , the main 
path would be used to indicate the accident path through the storybuild with subpaths used to indicate branches when there 
is more than one victim:
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10.4 Adding, deleting and renaming paths
 
To add a new path, right click in the lower left pane and choose add.

 
You will then be presented with a dialogue asking for the path name and parent:
 

 
The name of the path is simply the name that appears in the path area. If the path is a new path then its parent should be 
set to 'None'. If it is a branch of an existing path (e.g. an accident which has multiple victims) then the parent should be the 
existing path (e.g. the accident reference).
 
Similarly to rename a path or change its parent, choose the Edit menu option and to delete a path, choose delete. 
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10.5 Making and editing paths
 
Path editing is only available in Path mode. (See Standard toolbar, Modes of Operation.)
 
To edit a path, select the path you want to edit in the path list. Then do one of the following:
 
1. To add boxes to a new path or append them to an existing path, left click on the boxes required.
 
2. To add a box to the start of a path, hold down the ctrl key and click on the required box.
 
3. To remove a box from a path, right click on the box and choose delete.
 
4. To insert a box between two boxes of a path, left click on the red line joining the two boxes and drag it over to the box 
that is to be inserted.  
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10.6 Multiple path edit
 
Multiple Path editing is only available in Fixed mode. (See Standard Toolbar.)
 
Multiple Path edit allows you to edit the ordering of a path or number of paths passing through a box by dragging the cursor 
from a box with the selected path or paths to another box. The effect will be to add all the selected paths in the new box
 
To edit a path or paths, select the path or paths in the path list or from the right click Box Menu using Select Paths . 
Identify which boxes in the path you wish to edit then do one of the following:
 
1. To include a box before the selected box in the path hold down Alt and drag the cursor from the selected box onto the 
other box.
 
2. To include a new box after the selected box in the path hold down Alt+Shift and drag the cursor from the selected box 
onto the other box.  
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10.7 Make path visible
 
To make all the boxes associated with a path visible, right click on the path in the path list in the Path Name Workspace 
and select Make Visible from the menu

 
 
or use the Make Visible button in the Standard toolbar .
 
NOTE: Paths might still not be visible if there are Popups not activated  
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10.8 Selecting paths
 
In any mode other than Path Mode all selected paths will be shown in the Storybuild

Paths can be selected by a variety of means:
 
1. On the Standard toolbar (see 4.1.2 Path select: 3 buttons) all paths can be selected in one go, or deselected in one go.
 
2. Individual paths can be selected by clicking on the path list. Multiple paths may be selected from the path list using the 
Shift and Ctrl keys in the usual way
 

 
If the cursor is held over the path list the number of selected paths is shown at the bottom (4 of 205 paths in this case)
 
3.. By right clicking on the path list and choosing 'Invert Selection', you can choose all the unselected paths and unselected 
the previously selected paths.

 4. By right clicking on the path list and choosing 'Select Identical', you can select all paths that are identical to a given path.
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 5. By going to the view menu and choosing the Path Search items. See Path Search.

 6. If you wish to select all the paths that go  through a particular box, right click on the desired box and click on 'Select 
Paths' in the menu.

7. When the cursor is over a box and the shift key is held down then the information is displayed for all paths passing 
through the box as opposed to only the selected ones.

8. To select all paths that are the same(i.e. go through the same sequence of boxes) as a given path, right click on the path 
in the path list and choose Select Identical. 

Deselect:

To deselect paths use the deselect button on the toolbar
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10.9 Path counts
 
For selected paths, in the main drop down menu View, select Path Count Info.  This displays the path/accident frequencies 
and number of children [victims] beneath the boxes in the boxes workspace.
If the cursor is held over the box the names of the paths are shown along the bottom  left of the screen as shown below
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10.10 Paths in front
 
This option enables the user to either view the paths in front of the boxes or behind the boxes.  To set the path view to front 
click on View>Paths in Front to check it.  To set the path behind the boxes simply uncheck the option. 
See View menu 
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10.11 Path search
 
It is possible to select paths that satisfy a certain condition. To do this, ensure the path selecting panel is visible (if it is not, 
go to the View menu and choose Path Search). Queries can be built by typing in box numbers and keyword or by clicking 
on boxes with keywords selected.
 
When a query has been set up click on the Select button.  This will select all the paths according to the query
 

 
The table below shows the search keywords available to the user:
 
And - paths that satisfy all the entered box numbers
Or - paths that satisfy either of the two or more box numbers
Not - paths that does not contain the searched box numbers
Before - paths that goes through before the searched box number
After - paths that goes through after the searched box number
iBefore - paths that goes through immediately before the box number 
iAfter - paths that goes through immediately after the box number
 
Examples of possible queries are:
 
30 - all paths that go through box 30.
20 and 56 - all paths that go through boxes 20 AND 56.
20 or 56 - all paths that go through boxes 20 or 56 (or both)
20 and not 56 - all paths that go through box 20 but not box 56
10 Before 20 - all paths that go through box 10 before box 20 (i.e. all paths going through 10 then 20 will be returned 
regardless of anything boxes in between)
6 After 5 - all paths that go through box 6 after box 5 (i.e. all paths going through 5 then 6 will be returned regardless of 
anything boxes in between)
10 iBefore 20 - all paths that go through box 10 immediately before box 20 (i.e. path going through 10 then 20 will be 
returned but not if its going through 10 then 15 then 20)
6 iAfter 5 - all paths that go through box 6 immediately after box 5 (i.e. path going through 5 then 6 will be returned but not 
if its going through 5 then 8 then 5)
 
It is possible to build up queries by clicking on boxes. If the 'And' button is selected, when a box is clicked, it will be added 
as an additiional requirement e.g. if, starting with a blank query, the user clicks on boxes 3, 5 and then 8, the resulting 
query will be '3 and 5 and 8'. Similarly, if the 'Or' button had been selected, '3 or 5 or 8' would have resulted. The user can 
switch between 'And' and 'Or' as the query is built up.
 
If the 'Not' button is checked, a 'not' statement is added before each box. Thus to enter '20 and 5 or not 4' the steps would 
be:
1. Make sure 'And' is selected and 'Not' is unchecked.
2. Click on box 20 followed by box 5.
3. Choose 'Or' and check 'Not'
4. Click on box 4.
 
The '(...)' button allows the insertion of parentheses into the query. The 'Clear' button clears the current query and the 'Close' 
button hides the panel.  
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10.12 Path notes
 
Path Notes allow the user to add notes description to individual paths or for the Storybuild as a whole (see Storybuild 
Notes).  The Path Notes window allows the user to add, edit or delete note descriptions related to each Path.  The data will 
be stored in the database.
 
To edit/delete individual paths notes, right click on the desired path and select 'Edit Note' or 'Delete Note'.  
Paths with notes are shown with the icon below

 
To open the Path Notes window for multiple edit/delete, click on View->Path Notes from the drop down View menu.  The 
following screen will appear:

 
The Path Notes window can display all the paths available or those with a note attached depending on what the user has 
selected from the two buttons on the toolbar.  To add/edit/delete the user can double click on each Path to bring up an edit 
menu for data changes.
 

112



 
Complete the details of the notes to be stored and close window.  You will be prompted to save the data.  
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11.1 Viewing data in a table
 
The statistics module is a very useful tool to display information on all of the bowtie in a tabular format that can be exported 
to Microsoft Excel for further statistical analysis.
 
To open the statistics form click the button on the Forms toolbar or View -> View Statistics on the dropdown  menu bar.  
The path search option is also available on the statistics form using the dedicated dropdown view menu.  For further 
information on constructing queries see 10.11 Path Search.  
 

 
 
The buttons along the top have the following functions:
 
Refresh Paths - Refresh the path list
Generate for All Paths - Generate the selected report for all of the paths in the current Storybuild
Generate only for Selected Paths - Generate the selected report for the selected paths in the current Storybuild (requires 
Get Selected Paths to be selected first)
Get Selected Paths - Transfer the paths that are selected from the Main Window
Main Window - Toggle the view to the Main Window
Export - Export the current report to Microsoft Excel
 
The various tabs define the different report formats available to be displayed and exported:

1. Bowtie: This is designed for exporting data about the individual boxes that go to make up a Storybuild. The fields that 
make up this report are: Number, Code, Name, Description, Left Children, Right Children, Linked Boxes, Path Count, 
Paths. 
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Clicking on the column headers will sort on the basis of the selected column contents
 
2. Box Paths: This produces a subset of the Bowtie report; in particular, it lists details of the paths through each box. The 
fields listed are: Number, Name, Count, Paths. 
 
3. Path List*: This lists the relevant paths together with the box sequences they represent. A 'Subpath' field is also present; 
an 'X' in this field indicates the path is a subpath and its parent is the first path above it without an 'X'. The fields listed are: 
Name, Subpath, Sequence.
 
4. Path Sequences*: This exports all path sequences together with the names of paths that follow those sequences. The 
fields listed are: Sequence, Names.
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11.2 Exporting data to MS Excel
 
This can be done by opening the statistics window and clicking on the export button with the required data and tab 
selected.  See 11.1 Viewing data in a table.  So long as the Excel file remains open, exporting will continue to create 
worsksheets in the same file.
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For other export options see 3.8 Export menu and 8.2 Tree view data export. 
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12.1 Print function
 
Storybuilder has a print function that enables the user to print out selected pages of the storybuild bowtie.  Storybuilder will 
automatically calculate the number of pages required for the whole of the current bowtie.  The user will then have the option 
to select which page number they would like to print and how many copies via the print menu.  The print menu can be 
accessed via File and then click on Print.  The following dialogue will be shown:
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12.2 Page breaks
 
In the View menu, Page Breaks allow the user to view the Storybuild with the page breaks in dotted lines indicating the 
layout on each page.  This helps the user to move and customise the position of boxes for better printing.  
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12.3 Printer margin
 
The user is able to specify the Printer Margin via File and then click on Printer Margin.  The measurements are in mm and 
the user is able to specify the top, left, bottom and right margin.
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12.4 Page Setup
 
The user is able to customise the page set up of the printing of Storybuilder via the Page Setup form.  To activate the Page 
Setup go to File and click on Page Setup. 
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13.1 Identify required Storybuild  

See also 1.5 Storybuild types

The following queries allow the user to identify which Storybuild from the 36 Storybuilds is needed to examine a particular 
kind of accident.
Was the victim a victim of....

Human or animal aggression? 
YES 
20.1 Victim of human aggression 
20.2 Victim of animal behaviour 
  NO  

Uncontrolled Fall? 
   YES 
1.1.1 Fall from height - ladder & steps 
1.1.2 Fall from height - scaffold 
1.1.3 Fall from height - roof 
1.1.3 Fall from height - floor 
1.3 Fall down stairs or ramp         
1.2 Fall on same level 
Fall other:
 1.1.3 Fall from height - fixed platform 
 1.1.5.1 Fall from height - moveable platform 
 1.1.4 Fall from height - hole in the ground 
 1.1.5.2 Fall from height - non-moving vehicle 
 1.1.5.3 Fall from height - other 
  11 Fall from moving vehicle 
NO 

Contact with falling object? 
YES 
3.1 Falling object crane, part of crane or crane load 
3.2 Falling object other 
NO

Contact with machine or hand held tool? 
YES 
7 Contact with hand held tool held by self 
6 Contact with hand held tool held by other person 
8.1 Contact with moving parts of a machine 
8.3 Trapped between/against machine or structure 
NO

Contact with vehicle? 
YES 
2 Struck by moving vehicle 
3.2 Contact with overturning vehicle 
11 In or on moving vehicle with loss of control 
NO

Contact with an object? 
YES 
4 Contact with a flying object 
5 Contact with rolling/sliding object or person 
6 Contact with object person is carrying or using 
8.2 Contact with hanging/ swinging object 
9 Moving into an object 
NO
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Contact with a hazardous substance? 
YES 
14.1 Release from an open containment 
15 Release from a normally closed containment 
22.1 Exposure to hazardous atmosphere in confined space 
22.2 Exposure to hazardous atmosphere through breathing apparatus 
14.2 Other - Exposure to hazardous substance without Loss of Containment 
NO 

Contact with another substance? 
YES 
10 Buried by bulk mass 
23 Immersion in liquid 
24 Too rapid (de)compression 
NO

Contact with electricity? 
YES 
12 Contact with electricity 
NO

Heat, fire, explosion? 
YES 
13 Contact with extreme hot or cold surfaces or open flame 
17 Fire 
27 Explosion 
NO

Muscular exertion? 
YES  
25 Extreme muscular exertion 
NO

Make own bowtie!
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14.1 Box codes guide
 
Box codes can be entered using the box editor. See 6.1.3 Box editor.
 
Box codes help to identify a type of event.  
 
Box codes will sort the boxes in Code View of Tree View
 
Box codes will enable exports to MS Excel to be sorted and selected
 
 
The following codes are used in the 36 Storybuilds
A (activity at time of accident)

ABS (Absence from work)

BFM (Barrier Failure Mode)
1_BFM (Barrier failure mode 1 which is linked to 1_DS, 1_T)

BSM (Barrier Success Mode)
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BSU (Barrier State Unknown)

BWT (Transfer to/from another bowtie)

CE (Centre event)

DDF (Dose Determining Factor)

DS (Delivery system failure)
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ET (Equipment type - often using the ESAW classification)

FOD (Final Outcome Death)

FOI (Final Outcome Probably Not Permanently Injured)

FOP (Final Outcome Probably Permanently Injured)

G (Group box  - identifies a group of events)
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HOSP (Whether hospitalised)

IF (Incidental factor)

INJP (Part of body injured - using ESAW classification)

INJT (Type of injury - using ESAW classification)

LCE Loss of control event)
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PSB (Primary safety barrier)

REG (Regulations)

SSB (Support safety barrier)

T (Barrier task)

1_T (Barrier task which is linked to 1_DS, 1_BFM) 
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15.1 Keeping notes
 
Storybuilder has a functionality that enables the user to add notes associated with a file.  To activate the Notes menu in the 
File menu click on Notes.  You will see the following:

 
 
This is a notepad function that allow the user to type a large amount of text with customisable fonts, layout, margins and 
bullets.  Once the user has finished typing the memo simply close and save the notes.  The notes will be saved with the file 
and can be edited either via File>Notes or via a right click on an empty area of the boxes workspace and select Edit Notes.  
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16.1 Importing from an MS Excel file or text file
 
1.1.1 What import does
The import function allows boxes and paths to be automatically created in a Storybuild based on an MS Excel (*.xls) or tab 
delimited text file (*.txt). Only the excel file example is displayed here (similar process for txt file which in any case can be 
converted to excel)
Use import with .xls files (does not currently work with .xlsx files)
When an import is done from an excel sheet that sheet will not be available until Storybuilder program is closed.
The purpose of importing data is to:
Create new boxes when there are new data for existing paths
Import new paths for existing boxes
A combination of the above 
The file of data for import must contain:
a column with path names, and 
one or more columns of data 
Import will create a new box for every new unique name for a piece of data.  If there are 50 cells with the word "competence" 
there will be one box created with 50 paths
An example is shown below.  
In this example the first column lists the accident record identifiers (path names), the second column is the type of industry 
with a 2 figure code, and the third column is the industry broken down into more subdivision.
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WARNING: For versions pre v. 17.  DO NOT HAVE EMPTY CELLS. Rather than having blank cells, type the word 
"Unknown" or "null" in these cells otherwise a separate "null" box will be repeatedly created in Storybuilder for every empty 
cell so this is to be avoided.  If text such as Unknown is used all the paths with empty cells will go through a single box 
called "Unkown", keeping the Storybuild diagram small 
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16.2 Selecting import box
 
1. Right click on the desired box in the bowtie 
2. click on  'Import Excel Path Data' (or 'Import Path Data' if it is a tab delimited text file). 
In the figure below, the box coded BIK is the one selected. This box is the "import box".  The user is going to import the two 
columns of data from the excel sheet above onto the import box.
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16.3 Import window
 
See first Importing data and Selecting import box
After selecting the "Import Excel Path Data" a pop-up window will appear as shown below: 

 
In this window continue as follows:

Filename: 
Allows the user to set the source of the Excel file.

Sheet: 
Allows the user to select which worksheet of the file to import from.  Once a sheet is selected, the worksheet will appear on 
the window below (the worksheet name appears twice - just pick the first one)
The result for the example is shown below
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Path Col: 
This has to show the order number of the column in the Excel file containing the path names. In the example it is column 1. 
To automatically set the column number left click on a record in the path column and drag the cursor to the Path Col box, 
then release.  The column number will automatically appear.

Add new Paths:
To the right of the Path Col, tick the box ONLY IF you wish to add all paths that are not currently present in the storybuild 
as listed in the path names workspace.

Columns: 
This initially shows the number of data columns in the worksheet (so, excluding the paths column).  The number of columns 
required for import can be changed here. For example if only 6 of the total columns of data were going to be used this can 
be changed to 6 then click on Apply.  On the left in the list box are then displayed a list of the number of columns required.  
Note that these numbers do not correspond to the position number of the columns which will eventually be selected.

Row Headers: 
The number of rows that are classed as headers in the Excel file. In this case it is two.  The first row is a dummy row 
required for some internal functionality. (Earlier versions of Storybuilder may show only one header - no dummy row)

REMOVE DEPENDENCIES
If this is unchecked the accident paths across the columns will be structured as dependent boxes each one hanging on the 
other in the accident path.  If this is checked the columns of data will be imported as blocks (Earlier versions of Storybuilder 
may not have this option)

Column List
Click on one of the columns in the list box.  A column is only selected when it is highlighted.  Deal with each column in 
turn.  When a column in the list is selected there appear two boxes
Field Type and Data Col.  
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Data Col: 
Relevant Column number. This can be automatically generated by left clicking on one of the data cells in the relevant 
column of the displayed sheet and dragging it to and releasing it in the Data Col box.  Here in the example the list Column 2 
will use data from Data Column 2.

Field Type: 
Set the data type for each data column
Use the drop down menu.  
In the example "string" is selected.  This will cause the content of the column cells to appear as box names exactly as 
displayed. Common names will go into one box. See Ranges

Ranges: 
To set the data ranges for a number or a date field type, first select the column, set the field type, set the From and To 
range and press the add button.
 
Date or Number can selected if the user wishes to group the data rather than an individual box for each unique data point.  
For example ages could be grouped such as 10-19, 20-29 etc. and boxes will be generated with those group names.  The 
set-up is shown in the example below.  The user types in from and to numbers and then clicks on Add to create data group
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Side: 
Specify which side of the 'import box' you would like to import the child boxes - left or right. 
Data box side refers tothe boxes created from the column data and 
Side refers to the group boxes made by the column headings

Orphaned Paths
This has to do with paths without boxes whether they should be ignored.  Determine whether paths that do not relate to the 
Ancestor and Import Box are to be added to the end of the path with the same name or be ignored.

Insert State
A path is a sequence of boxes through the Storybuild diagram identified by a path name and shown by a line. When 
importing it can be specified where in the sequence the imported boxes should be.  Options are
Start of Path i.e. Path goes through the box at the start of the sequence 
End of Path i.e. Path goes through the box at the end of the sequence
Before/After Ancestor and Before/after Descendent determines where the path will go through the box which is not at the 
beginning or end of a path sequence.  The default Ancestor is the Root box.  Will it go through the box before or after the 
path goes through the Ancestor of the box or before or after it goes through the Descendent of the box. 
To set the Ancestor as another box right click on the desired box and click on 'Set Ancestor'. Descendents are then boxes 
which derive from the Ancestor. The importance of these boxes is that when the import is carried out, for each path the first 
box along the path that is a descendent of the 'ancestor' box is found and the first child box is added to the path before or 
after this box depending on what is selected. Subsequent boxes are inserted before or after the previous child. Paths can 
also be added to the start or to the end of the existing paths.

Code: 
The Code for the new boxes on the selected column. 

Box Num: 
The Box number for the new boxes on the selected column
.
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Description: 
The Description for the new boxes on the selected column.

 
Box Style: 
The Box shape for the new boxes on the selected column.

 
Border Colour: 
The Border Colour for the new boxes on the selected column.

 
Border Width: 
The Border Width for the new boxes on the selected column.

 
Fill Colour: 
The Box Fill Colour for the new boxes on the selected column.
 
 
When the set up is complete, go to 16.4 The import process
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16.4 The import process
 
In the import window click the OK button to import the paths. 
 
The process is as follows:
For each row in the file, the program finds the paths with the same names as existing paths in the path name workspace.
It then finds a child box of the import box with the same name as that contained in the first column; if no such child exists, 
a new child box is added.
The program adds the corresponding matched paths to the box; the location of the box in the sequence of boxes on the 
path depends on the option chosen. (See below.) 
The next child column is then considered and the process is repeated. 
 
Up to 10 columns of data can be imported in one import.  
NOTE: The effect depends on whether data was imported with Remove Dependencies checked or unchecked. 
In the following diagram the import was a 6 column import first showing with dependencies and second without
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17.1 Macro User Guide
 
This is a separate guide.  For a quick start see 3.3 Macros menu. 
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18.1 Selecting the paths with Story Filter
 
 
PURPOSE
 
To make a selection of GISAI records from Story Filter and then make these appear as highlighted paths in Storybuilder 
using the Storybuilds made with GISAI data.  The latest Storybuilds appear together in one file  (currently called a Superfile)
 
VERSIONS
 
This only works with versions 44 and above of Story Filter and version 2.0.0.29 and above of Storybuilder.
 
STORY FILTER SELECTION
 
The only selections available from Story Filter are those that appear on the selection screen.  Make a selection by pressing 
and selecting from as many fields as you want but don't press the analyse (Show Totals) button.  Instead select View, 
Filtered Paths List.  Then click on the export button.  See figure below. 
 
Once the export button is clicked you will be requested to provide a file name (with extension .sfp).  Actually it is just a text 
file which can be opened in notepad with the list of path names. 
 
For the next step see 18.2 dragging paths from Story Filter to Storybuilder.
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18.2 Dragging paths from Story Filter to Storybuilder
 
Start Storybuilder and open the Storybuild file that has the GISAI database (currently called the Superfile)
 
Open a file manager and drag the file of the exported filtered records ( see 18.1 Selections and links with Story Filter) onto 
the Boxes Workspace for a selected Storybuild
 
(Hint - you should find out from Story Filter which Storybuilds are relevant)
 
The records will be highlighted.
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Refresh tree view paths, 87, 91
Remove box from path, 104
Rename boxes, 62
Rename path, 103
Renumbering boxes, 43
Right box, 61
Root, 9, 45, 74
Root box, 45, 9, 95, 74

 S 
Save, 14, 25, 30, 50
Save as, 30
Save path list, 25
Save path selection, 25
Saved paths workspace, 25
Scale, 32
Scrolling, 75
Select path(s), 69, 59, 43, 109, 107, 101, 111
Select storybuild, 12, 53, 122
Selected path boxes grid, 35
Selecting, 109, 69, 107
Set ancestor, 134
Set print margins, 30
Settings, 41
Size, 32
Standard Toolbar, 43
Starting, 5, 20
Statistics, 47, 114
Statistics for selected paths, 47, 114
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Storybuild, 11, 12, 35, 53
Storybuild Add/edit/delete menu, 54
Storybuild list order, 56
Storybuild name, 54
Storybuild name workspace, 25, 54
Storybuild structure, 9, 11
Storybuild workspace, 53
Storybuilds, 11, 11, 12, 12, 122
StoryFilter, 141, 142
Structures, 9, 9, 9, 20, 20, 48, 74

 T 
Toolbar(s), 23, 40, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52
Tools menu, 41
Tree view, 95, 47, 39, 91, 87
Tree view - as navigator, 95
Tree view code view, 87
Tree view export data, 91
Tree view graph view, 87
Tree view menu, 91
Tree view numberless view, 87

 U 
Unfold, 52, 82
Uses, 11

 V 
Vicitms, 99, 109
View, 39, 75
View menu, 39
Viewing paths, 107
Viewing statistics, 39, 114, 116
Visibility, 75, 106

 W 
Which hazard, 12, 122
Workspace(s), 25

 Z 
Zoom, 32, 96, 97
Zoom in, 32, 96
Zoom out, 32, 96
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